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GO! with Office 2016

GO! with Office 2016 is the right approach to learning for today’s fast-moving, mobile

G 0 l environment. The GO! Series focuses on the job and success skills students need
Excel 2015

GASKIN

to succeed in the workforce. Using job-related projects that put Microsoft Office

into context, students learn the ~ow and why at the moment they need to know, and
because the GO! Series uses Microsoft procedural syntax, students never get lost in
the instruction. For Office 2016, the hallmark GO! guided practice-to-skill mastery
pathway is better than ever. Not only do students have multiple opportunities to work
live in Microsoft Office to practice and apply the skills they have learned, but also, the
i instructional projects are now Grader projects, so students can work live in Office and

— receive auto-graded feedback as they learn!

By combining these new instructional Grader projects with the variety of existing Grader
projects and the high-fidelity simulations that match the text, students have an effective
pathway for learning, practicing, and assessing their abilities. After completing the instructional projects,
students are ready to apply the skills with a wide variety of progressively challenging projects that
require them to solve problems, think critically, and create projects on their own. The new GO! with
Google projects also enable students to apply what they have learned in a different environment, and the
integrated MOS objectives make this the one resource needed to learn Office, gain critical productivity
skills, and prepare to get MOS certified!

What’s New

Coverage of new features of Office 2016 ensures that students are learning the skills they need to
work in today’s job market.

NEW MylTLab 2016 Grader Projects In addition to the homework and assessment Graders already
available, the A and B instructional projects are now Graders, enabling students to learn by doing live in
the application and receive the instant feedback they need to ensure understanding.

MylTLab HTML 5 Training & Assessment Simulations for Office 2016 These simulations are
rewritten by the authors to match the pedagogical approach of the textbook projects and to provide a
direct one-to-one learning experience.

NEW Google Projects For each A and B instructional project in Chapters 1-3, students construct a
parallel project using Google productivity tools. This gives students the opportunity to think critically
and apply what they are learning about Microsoft Office to other productivity tools, which is an essential
job skill.

NEW MOS Preparation MOS objectives are integrated into the text for easy review and reference for
students who are preparing for a MOS certification exam. A MOS appendix is also included to provide a
comprehensive list of the exam objectives.

NEW Lessons on the GO! How do you teach software that is constantly updated and getting new
features all the time? This new project type will cover newer Microsoft apps such as Sway and MIX and
things yet to come! These lessons are found in MyITLab and the Instructor Resource Center, and come
with instructional content, student data files, solutions files, and rubrics for grading.

GO! To Work Page Here, students can review a summary of the chapter items focused on employability,
including a MOS Objective summary, Build Your ePortfolio guidelines, and the GO! For Job Success
soft skills videos or discussions.
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Application Capstone Projects MYITglFaadg Capstone projects for each application provide a variety of

opportunities for students to ensure they have reached proficiency.

FOUR Types of Videos Students enjoy video learning, and these videos help students learn and gain
skills and insight needed to succeed in the workforce.

* (NEW) GO! Walk Thru: Give students a quick 30-second preview of what they will do and create—
from beginning to end—by completing each of the A and B Instructional Projects. These videos
increase the student’s confidence by letting the student see the entire project built quickly.

* GO! Learn How (formerly Student Training): Students learn visually by viewing these instructor-led
videos that are broken down by Objective for direct guidance. This is the personal instruction students
need—especially outside of the classroom—to answer the How do I? questions.

* GO! to Work: These videos provide short interviews with real business information workers showing
how they use Office in the workplace.

* GO! for Job Success: These videos or discussions relate to the projects in the chapter and cover
important career topics such as Dressing for Success, Time Management, and Making Ethical Choices.

Expanded Project Summary chart This easy-to-use guide outlines all the instructional and end-of-
chapter projects by category, including Instruction, Review, Mastery and Transfer of Learning, and
Critical Thinking.

In-text boxed content for easy navigation Another Way, Notes, More Knowledge, Alerts, and By

Touch instructions are included in line with the instruction—not in the margins—so students won’t miss
this important information and will learn it in context with what is on their screen.

MylTLab 2016 for GO! Let MyITLab do the work by giving students instantaneous feedback and
saving hours of grading with GO!’s extensive Grader Project options. And the HTMLS5 Training and
Assessment simulations provide a high-fidelity environment that provide step-by-step summary of
student actions and include just-in-time learning aids to assist students: Read, Watch, Practice.

All other end-of-chapter projects, C, D, H, I, J, K, L, M, N, and O, have grading rubrics and solution
files for easy hand grading. These are all Content-based, Outcomes-based, Problem-Solving, and Critical
Thinking projects that enable you to add a variety of assessments—including authentic assessments—to
evaluate a student’s proficiency with the application.

IT Innovation Station Stay current with Office and Windows updates and important Microsoft and
office productivity news and trends with help from your Pearson authors! Now that Microsoft Office is
in the cloud, automatic updates occur regularly. These can affect how you to teach your course and the
resources you are using. To keep you and your students completely up to date on the changes occurring
in Office 2016 and Windows 10, we are launching the IT Innovation Station. This website will contain
monthly updates from our product team and our author-instructors with tips for understanding updates,
utilizing new capabilities, implementing new instructional techniques, and optimizing your Office use.

Why the GO! Approach Helps Students Succeed

GO! Provides Personalized Learning

MylITLab from Pearson is an online homework, training, and assessment system that will improve
student results by helping students master skills and concepts through immediate feedback and a robust
set of tools that allows instructors to easily gauge and address the performance of individuals and
classrooms.

MyITLab learning experiences engage students using both realistic, high-fidelity simulations of
Microsoft Office as well as auto-graded, live-in-the-application assignments, so they can understand
concepts more thoroughly. With the ability to approach projects and problems as they would in real
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life—coupled with tutorials that adapt based on performance—students quickly complete skills they
know and get help when and where they need it.

For educators, MyITLab establishes a reliable learning environment backed by the Pearson Education
24/7, 99.97 percent uptime service level agreement, and that includes the tools educators need to track
and support both individual and class-wide student progress.

GO! Engages Students by Combining a Project-Based Approach with the Teachable Moment

GO!’s project-based approach clusters the learning objectives around the projects rather than around
the software features. This tested pedagogical approach teaches students to solve real problems as they
practice and learn the features.

GO! instruction is organized around student learning outcomes with numbered objectives and two
instructional projects per chapter. Students can engage in a wide variety of end-of-chapter projects where
they apply what they have learned in outcomes-based, problem-solving, and critical thinking projects—
many of which require students to create the project from scratch.

GO! instruction is based on the teachable moment where students learn important concepts at the
exact moment they are practicing the skill. The explanations and concepts are woven into the steps—
not presented as paragraphs of text at the beginning of the project before students have even seen the
software in action.

Each Project Opening Page clearly outlines Project Activities (what the student will do in this project),
Project Files (what starting files are needed and how the student will save the files), and Project Results
(what the student’s finished project will look like). Additionally, to support this page, the GO! Walk Thru
video gives students a 30-second overview of how the project will progress and what they will create.

GO! Demonstrates Excellence in Instructional Design

Student Learning Outcomes and Objectives are clearly defined so students understand what they
will learn and what they will be able to do when they finish the chapter.

Clear Instruction provided through project steps written following Microsoft® Procedural Syntax to
guide students where to go and then what to do, so they never get lost!

Teachable moment approach has students learn important concepts when they need to as they work
through the instructional projects. No long paragraphs of text.

Clean Design presents textbook pages that are clean and uncluttered, with screenshots that validate the
student’s actions and that engage visual learners.

Sequential Pagination displays the pages sequentially numbered, like every other textbook a student
uses, instead of using letters or abbreviations. Student don’t spend time learning a new numbering
approach.

Important information is boxed within the text so that students won’t miss or skip the Another
Way, By Touch, Note, Alert, or More Knowledge details so there are no distracting and “busy-
looking” marginal notes.

Color-Coded Steps guide students through the projects with colors coded by project.

End-of-Project Icon helps students know when they have completed the project, which is especially
useful in self-paced or online environments. These icons give students a clearly identifiable end point for
each project.

GO! Learn How Videos provide step-by-step visual instruction for the A and B instructional projects—
delivered by a real instructor! These videos provide the assistance and personal learning students may
need when working on their own.
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GO! Delivers Easy Course Implementation

The GO! series’ one-of-a-kind instructional system provides you with everything you need to prepare for
class, teach the material, and assess your students.

Prepare

Office 2013 to 2016 Transition Guide provides an easy-to-use reference for updating your course
for Office 2016 using GO!

Annotated Instructor Tabs provide clear guidance on how to implement your course.
MyITLab Implementation Guide is provided for course planning and learning outcome alignment.
Syllabus templates outline various plans for covering the content in an 8-, 12-, or 16-week course.

List of Chapter Outcomes and Objectives is provided for course planning and learning outcome
alignment.

Student Assignment Tracker for students to track their own work.

Assignment Planning Guide Description of the GO! assignments with recommendations based on
class size, delivery method, and student needs.

Solution Files Examples of homework submissions to serve as examples for students.
Online Study Guide for Students Interactive objective-style questions based on chapter content.

Teach

The Annotated Instructors Edition includes the entire student text, spiral-bound and wrapped with
teaching notes and suggestions for how to implement your course.

Scripted Lectures present a detailed guide for delivering live in-class demonstrations of the A and B
Instructional Projects.

PowerPoint Presentations provide a visual walk-through of the chapter with suggested lecture
notes included.

Audio PowerPoint Presentations provide a visual walk-through of the chapter with the lecture
notes read out loud.

Walk Thru Videos provide a quick 30-second preview of what the student will do and create—from
beginning to end—by completing each of the A and B Instructional projects. These videos increase
the student’s confidence by letting the student see the entire project built quickly.

Assess

A scoring checklist, task-specific rubric, or analytic rubric accompanies every assignment.

Prepared Exams provide cumulative exams for each project, chapter, and application that are easy to
score using the provided scoring checklist and point suggestions for each task.

Solution Files are provided in three formats: native file, PDF, and annotated PDF.
Rubrics provide guidelines for grading open-ended projects.
Testbank questions are available for you to create your own objective-based quizzes for review.
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Grader Projects

XX

Projects A & B (Guided Instruction)

Project E Homework (Formative) and Assesment (Summative) (Cover Objectives in Project A)
Project F Homework (Formative) and Assesment (Summative) (Cover Objectives in Project B)
Project G Homework (Formative) and Assesment (Summative) (Cover Objectives in Projects A and B)
Application Capstone Homework (Formative review of core objectives covered in application)

Application Capstone Exam (Summative review of core objectives covered in application—
generates badge with 90 percent or higher)

GO! with Office 2016



GO! Series Hallmarks

Teach the Course You Want in Less Time

A Microsoft® Office textbook designed for student success!

Clearly defined
Learning Outcomes
and Objectives

Introducing Microsoft

Creating Documents with
Word 2016

Microsoft Word 2016

[FTag OUTCOMES PROJECT
/l Q Create a flyer with a picture. 1B

OBJECTIVES

1. Create a New Document and Insert Text
2. Insert and Format Graphics

3. Insert and Modfy Text Bores and Shapes.
4. preview and Print a Document

Word 2016

Visual Design - Engages
students and provides a clear
learning pathway.

OBJECTIVES
5. Change Document and Paragraph Layout
6. Create and Modfy Lists
2. Set and Modify Tab Stops
8. Insert a SmartAt Graphic and an Online Video.

GO! To Work videos -

Word 2016: Introduction

Contentl Defined by Merriam-Webster' oniine
dictionary as "the topic or matter treated in a written
work” and also as “the principal substance (as written
mater, lustrations, or music) offered by a World Wide
Website,” content is what you consume when you read
on paper or online, when you watch video, or when you
lsten to any kind of music—live or recorded.

Content is what you create when your own words
or performances are recorded in some form. For creating
contentin the form of words, Microsoft Offce 20161is a
great choice. Rather than just a tool for word processing,
Word is now a tool for you to communicate and
collaborate with others. When you want to communicate

with pictures o images in your Word document, Office
2016 has many features to help you do so. You can use
Microsoft Word 2016 on a Windows desktop, laptop, or
tablet. f your PC is touch-enabled, you will be able to use
your fingers to work with Word. For example, the ribbon
‘expands to make it easy t0 tap commands and you can
resize images by moving your fingers on the screen.

Best of al, Microsoft Word 2016 s ntegrated ino the.
cloud. f you save your documents to your cloud-based
storage that comes with any free Microsoft account, you
an retreve them from any desice and continue to work
with and share your documents. Enjoy learning Word
20161

In This Chapter =] &5

In this chapter, you will begin your study of Microsoft
Word, one of the most popular computer software
applications and one that almost everyone has a reason
0 use. You will use many of the tools and features in
Word 2016, such as applying attractive styles 1o your
documents. You can use Microsoft Word to perform basic
word processing tasks such as writing a memo, a report,
or aleter. i

The projects in this chapter elate to Sturgeon Point
Productions, an independent film company based in
Miami with offces in Detroit and Mitwaukee. The film
professionals procuce effective broadcast and branded
content for many industres, and provide a wide array.

of film and video production services. Sturgeon Point
Productions has won awards for broadcast advertising,

dia, music videos, and social media. The

tasks, such as creating sophisticated tables, embedding
qraphics, wiiting blogs, and creating publications. Word
is 2 program that (- and then add

mission of the company s to help et teltheir stories—
whether the story s about a socal ssue, a new product,

more advanced skills one at a time.

2 company, or a person.

of how Office is used in
various careers.

Provide real-work examples

Application Introductions - Provide
an overview of the application to prepare
students for the upcoming chapters.

Scenario = Each chapter opens with a
job-related scenario that sets the stage for
the projects the student will create.

Simulation Training and
Assessment - Give your
students the most realistic Office
2016 experience with realistic,
high-fidelity simulations.

27| Sales Report with Embedded
Column Chart and Sparklines

Project Activities - A project
summary stated clearly and quickly.

OJECT ACTIVITIES

In Activities 1.01 through 1.17, you will reate an Excel worksheet for Michelle Barry.
the President of Pro Fit Marietta. The worksheet displays the second quarter sales of cardio
equipment for the current year and includes a chart to visually represent the data. Your completed
worksheet will look similar o Figure 1.1

88 PROJECT FILES. [ vy TLab | ouriniucior v ot st Poc A v
[ M2 | L Grado syt g 1o WyiTLaslocae Grder

Project Files - Clearly shows
students which files are needed for
the project and the names they will

use to save their documents. L4 TROMECTREDES —

Project 1A, and then download the fils for this project.

NEW MyITLab Grader
projects for Instructional
A & B projects - Allow
students to work live in the
application to learn by doing.

For Project 1A, you wil need 7
New blank Excel workbook Lastname_Firstname_1A_Quarterly_Sales
Lastname_Firstname 1A Quarterly Sales
formulas (if your instructor requires)

t
il

@i

£

I
=7

Build from Scratch icons -
Indicate which projects students
build from scratch.

Project Results - Shows
students what successful
completion looks like.

NEW GO! Walk Thru
videos - Give students a
30-second overview of what they

[T ——

will create in the project. 0 -
T ———
350 Excel | Chapter 1: CREATING A WORKSHEET AND CHARTING DATA
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In-text Features

Another Way, Notes, More Knowledge, Alerts, and By Touch Instructions

Color Coding = Each chapter

has two instructional projects,
which is less overwhelming

for students than one large
chapter project. The projects are
differentiated by different colored
numbering and headings.

MOS Objectives - Are
highlighted throughout the
text to provide a review and

Microsoft Procedural
Syntax - Steps are written to put
the student at the right place at the
right time.

Teachable Moment -
Expository text is woven into the
steps—at the moment students
need to know it—not chunked
together in a block of text that will
go unread.

[ ————r—

FIGURE 1.7

exam prep reference.

End-of-Chapter

MOS Skills Summary - List
all the MOS objectives covered
in the chapter.

GO! To Work
U T

WA

MICROSOFT OFFICE SPECIAUIST (MOS) SKILLS IN THIS CHAPTER.

PROJECT 1A PROJECT 18

Actvity 1.05 | Wrapping Text Around a Picture Using Layout Options.

Recall that Layout Options enable you to control text wrapping—the manner in which text
displ

W Be s
D Tot

arrangements. Point

Fach con vis

O ANOTHER WAY

Project 1A Fiyer | Word 1.

Intext Callouts - Ensure that
students will read this important
material—Another Way, Notes,
More Knowledge, Alerts, and By
Touch instructions.

Sequential Pagination - Students
are given actual page numbers to navigate
through the textbook instead of confusing
letters and abbreviations.

Build Your ePortfolio - Provides

el 39

GO! For Job Success - Soft
skills, videos, and discussions

to prepare students with the soft
skills needed for today’s work
environment.

guidelines for creating an effective
representation of your course work.

— 1
=
o 07

PROJECT GUIDE FOR EXCEL CHAPTER 1

PROJECT GUIDE FOR EXCEL CHAPTER 1

GLOSSARY
GLOSSARY OF CHAPTER KEY TERMS.
96 Excl | chapter 1 cncave A womkseer awlararTig o

Review and Assessment Chart - Provides
an easy-to-use guide to all the instructional and end-
of-chapter projects by category from Mastery and
Transfer of Knowledge to Critical Thinking.

End-of-Chapter
Glossary - Gives
students an easy way to
review key terms.
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End-of-Chapter

Objective List - Every
end-of-chapter project includes
a listing of covered Objectives
from Projects A and B.

CONTENT-BASED ASSESSMENTS (MASTERY AND TRANSFER OF LEARNING)

Mastering Excel_Project 1E Gym Sales:

In the following Mast

Excel project, you will create a worksheet comparing

‘Apply 14 skils from
these Objectives:
1 ot oo and.
Naigstean bl

2 EnerDaaina
Vst

3 Corstuctand Copy
Fomasand s he
SUN uncton

4 fomat Celewith

Mege Centr, el

5 Chan Data o Ceste

the sales of different types of home gym equipment sold in the second quarter, Your
completed worksheet will look similar to Figure 1.58.

PROJECT FILES
For Project 1E, you will need the following file:
01_1E_Gym Sales.

You will save your workbook as:

Lastname Firstname_1E Gym Sales

PROJECT RESULTS

» Cobin i and
et ot
6 i,
Cobicd —
= - = i
H
3
——— i e ;
FIGURE 1.58
(Project 1E Gym Sales continues on the next page)
406 Excel | Chapter 1: CREATING A WORKSHEET AND CHARTING DATA

Grader Projects - In addition to the two Grader
Projects for the instructional portion of the chapter
(Projects A and B), each chapter has six MyITLab
Grader projects within the end-of-chapter material—
three homework and three assessment—clearly
indicated by the MyITLab logo.

‘Apply a combination
of the 14 and 16 sklls

Performance Criteria

Create formulas

Create a chart

Insert and format

sparklines.

CONTENT-BASED ASSESSMENTS (CRITICAL THINKING)

GO! Fix It Project 1H Team Sales MyITLab
GO! Make It Project 11 Agility Sales MylTLab
GO! Solve It Project 1) Kettlebell Sales MylTLab

GO! Solve It Project 1K Commission
PROJECT FILES
For Project 1K, you will need the following fe
201K Commission
You il save your workbook as:

Lastname_Firstname_1K_Commission

Open the file €01K_Commission and save it a5 Lastname_Firstname_1K_Commission
Complete the g Auto Fill headi d then
calculating the Total Commission for each month and for each region. Insert and format
appropriate sparklines in the Trend column. Format the worksheet atractively with a
title and subiite, check spelling, adjust column width, and apply appropriat i
formatting. Insert a char that compares the total sales commission for ¢ach region with
the as the cat d Include the file
‘name in the footer, add appropriate properties, and submit as directed.

Performance Level

Exemplary: You Proficient: You Developing: You
consistently applied  sometimes, butnot  rarely or never

CONTENT-BASED ASSESSMENTS (MASTERY AND TRANSFER OF LEARNING)

MasteringWord _ Project 1F Pitch Festival 1

I the following Mastery project, you will edit a document with information
that Sturgeon Point Product
printed results will look similar to those in Figure 1.55.

)

PROJECT FILES

6 Creteand MocyLiss
7 Saandtiodf i | For Project 1F, you will need the following file:
Sops

WOTF_Pitch_Festival

8 sena S,
e | Youwil save your document as:
viko

Lastname_Firstname_1F_Pitch_Festival

E4 PROJECT RESULTS

[

FIGURE 1.5
(Project 1F Pitch Festival continues on the next page)

Project1F Pich Festival | Word 207

Task-Specific Rubric — A matrix
specific to the GO! Solve It projects that

the relevant skills  always, applied the  applied the relevant
relevant skills skills

most effcent manner numbers were enterec,

incorectdata was slected.

formatte propery incorrect data was seected
orsparklines were ot
Tomatted.

(T LSO Formating s atvactve and | Adequately formatied Inadequate orna ormting.
and appropriately i but dificul toread

wnatiacive

[| END | You have completed Project 1K

Chapter 1: CREATING A WORKSHEET AND CHARTING DATA

states the criteria and standards for grading
these defined-solution projects.
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End-of-Chapter

Outcomes-Based Assessments - Assessments with open-ended solutions.

Outcomes-Based Assessments -
Assessments with open-ended solutions.

OUTCOMES-BASED ASSESSMENTS (CRITICAL THINKING)

RUBRIC:
The

That

approach solves the problem.

result

Your completed project
is of Professional Quality

Appro:
Quality if you:

s, there is no specific correct result, your result will depend on your approach to the
information provided. Make Professional Qualiry your goal. Use the folloy
rubric to guide you in fow 1o approach the problem and then to evaluate

oring
your

“The eriteria—Software Mastery, Content, Format and Layout, and Process—
represent the knowledge and skills you have gained that you can apply to solving the
problem. The fevels of performance—Professional Qualiy, Approaching Professional
‘Quality, or Needs Quality Improvements—help you and your instructor evaluate your

Your completed project is | Your completed
Prof i

project Needs Quality.
Improvements if you:

1software | P
Mastery approprite s, tools, and ate i, tools,and o features,or e nefficnt
methods to solve the probien.
2-Content
a erors of speling, or
ofspeling, rammr, o sty stye. Do nat sove the problem.
3-Format and
Layout and
ideas, clrfy function, Husiate | butnot others. Ovruse features, | nformation o ideas eary
S =
importance. features o
a-process. Use.
fopment, sef-assessm
revion, and reflecton,

Rubric | Word 213

Outcomes Rubric - A standards-based analytic rubric specific
to the GO! Think projects that states the criteria and standards
for grading these open-ended assessments. For these authentic
assessments, an analytic rubric enables the instructor to judge and

the student to self assess.

Working with Web-Based Applications and Services

Aciiy
Aciy.
ad
ik GetSaned.
Activity | G g

n hi you will use Google S)
ereated in Project 1B.

B From the deskiop, open your browser (1 browser
other than Edge),

report similar to the one you

Select the range B3:E3, on the menu bar click
Format, point to Text wrapping, and then click Wrap,

cick the Google Apps menu . Click Drive, and then if
necessary,sign n to your Google account.

T2 Open your GO! Web Projects folder—or click New
o create and then open this folder if necessary.

(Center these columnttles and spply Bl 5]

I Sclcct the range C4:C, on the men bar click
Format,point to Number, on the ly-out menu click

Sample Solution = Outcomes-based

assessments include a sample solution so the
instructor can compare student work with an

example of expert work.

FPCC Career Center

Student and Alumni Workshops

The FPCC Career Center is committed to helping you improve your job potential. We offer a number of
workshops that will help you improve your job skills. The following workshops are available to all
students and graduates at no fee.

Workshop
Word, Part 1

Word, Part 2

Word, Part 3

Excel, Part 1

Excel, Part 2

Excel, Part 3

Business Communication, Part 1 Writing business letters

Business Communication, Part 2~ Designing visual presentations.

Creating a Resume.

Topics Covered
Navigating the Word screen
Creating and saving documents
Creating and modifying lsts
Using tab stops

Creating and formatting tables
Editing text

Using proofing tools

Using templates.

Creating a report

Creating a newsletter

Using mail merge
Navigating the Excel screen
Creating a worksheet

Using formulas

Creating charts

Using functions

Formatting cells

Editing and moving data
Performing a what.f analysis
Creating and using tables
Using financial functions
Formatting worksheets

Writing memos
Delivering effective presentations

Creating effective resumes
Formatting resumes for different audiences

Lastname_Firstname_2L_Workshops

Number,and then f necessry.

IEB I the et pae, click NEW, nd
Shects Fi

navigate 1o your Student Data Files for this chapter, and
then in the Fille List, double-clck the Word document
Kly and

KD Ciick cell B4, ¢4 Type

and then click cll D4 Pres . Click cell E, point 10

the il handieinth Tower right comer of the el and
[

liminate exta typng, you will copy the data from a
Word document

I in the displayed Word document, clck anywhere in
e tent,and then i the upper et comer, click 0 selct
the Tuble Select 18] 0 seect the ntire Word table. Right-
lick anywhere over the selction, and thn cick Copy.
Close Word. Clos he File Exploer window.

I tn your blank Google Shect, with cll Al scie,
poin t0cel AL right-lick, and ten ik Paste.Inthe
column heading ares, point 0 the border betwien column
A and column B o isplay the E pointer, and then

BID Scict the range EA:E9. On the toolbar,click
Functions ], click SUM, and then press .

B Sclect he ange DA4E4, hold down G, and then
selectcel E10. On the menu bas, click Format,point (o
Number, an then n the ly-out menu lick Currency

old down (67, and then clck cell

E10. Apply Bold [¥].
Click cell A1, hold down Gir, and then click cell
A2, cell A10, and cell E10. With the four cell selected.

the toolbar, click Fill color . and then in the fourth
ik the ?

sightly sothat al of
410 displays

I3 Select the range ALE1L On the toolbar, click

Merge cells 5. On the toolbar; click the Atign arrow [].
and then click Center B, Repeat forthe range AZE2, nd
en apply Bokd[8110 clls A1 and A2

IED At the top of the worksheet, click the text Uniled
spreadshet, and then using your own name, type
Lastname.Firstname_EX_1B_ Web and press ENTER.

(GO! With Google continues on the next page)
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GO! Series Hallmarks

Google Projects for each

A & B instructional project in
Chapters 1-3 - Provide students the
opportunity to think critically and apply what
they are learning about Microsoft Office to other
productivity tools—an essential job skill.




All Instructor
Resources found
in MyITLab or at

pearsonhighered.

com/go

Student Materials

Student Data Files - All student data files are available in MyITLab for Office 2016 or at
www.pearsonhighered.com/go

FOUR Types of Videos help students learn and gain skills and insight needed to succeed in the

workforce.

e (NEW) GO! Walk Thru is a brief overview of the A & B instructional projects to give stu-
dents the context of what they will be doing in the projects

e GO! Learn How (formerly Student Training) instructor-led videos are broken down by
Objective for direct guidance; this personal instruction answers the “how-do-I"” questions

students ask.

e GO! to Work videos provide short interviews with workers showing how they use Office in
the workplace.

e GO! for Job Success videos or discussions relate to the projects in the chapter and cover
important career topics such as Dressing for Success, Time Management, and Making Ethical

Choices.

Matching and multiple choice questions provide a variety of review options for content
in each chapter.

MOS Objective quiz provides a quick assessment of student understanding of the MOS objec-
tives covered in the chapter. Helpful for courses focused on the pathway to MOS certification.

Available in MyITLab for Office 2016.

GO! with MyITLab
Gives you a completely integrated solution

Instruction ® Training = Assessment

All of the content in the book and MylITLab is written by the authors, who are instructors,
so the instruction works seamlessly with the simulation trainings and grader projects—
true 1:1. eText, Training & Assessment Simulations, and Grader Projects.

Instructor Resources

Annotated Instructor Edition = This instructor tool includes a full copy of the student text-
book and a guide to implementing your course depending on the emphasis you want to place on
digital engagement. Also included are teaching tips, discussion topics, and other useful pieces for
teaching each chapter.

Assignment Sheets - Lists all the assignments for the chapter. Just add the course informa-
tion, due dates, and points. Providing these to students ensures they will know what is due and
when.

Scripted Lectures - A script to guide your classroom lecture of each instructional project.

Annotated Solution Files = Coupled with the scorecards, these create a grading and scoring
system that makes grading easy and efficient.

PowerPoint Lectures - PowerPoint presentations for each chapter.
Audio PowerPoints = Audio versions of the PowerPoint presentations for each chapter.

Scoring Rubrics = Can be used either by students to check their work or by you as a quick
check-off for the items that need to be corrected.

Syllabus Templates - For 8-week, 12-week, and 16-week courses.
Test Bank - Includes a variety of test questions for each chapter.
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Instruction

Instruction: General

Syllabi templates demonstrate different approaches for covering the content in an 8-, 12-, or 16-week
course.

Application Intro Videos provide a quick overview of what the application is and its primary function.

GO! to Work Videos put each chapter into context as related to how people use productivity software in
their daily lives and work.

GO! For Success videos and discussions provide real-life scenarios exploring the essential soft skills
needed to succeed in the workplace and professional settings.

Instruction: Hands-0On using one or more of the following:

¢ Interactive eText allows students to read the narrative and instruction and also link directly to the
various types of videos included.

¢ (NEW) Walk Thru Videos provide a quick 30-second overview of what students will do in the A & B
instructional projects.

¢ Scripted Lectures are a detailed guide through the A & B projects from the book for you to use for
in-class demonstration.

e GO! Learn How (previously Student Training) videos are instructor-led videos that provide guided
instruction through each Objective and the related Activities.

¢ PowerPoint Presentations provide a visual walk-through of the chapter with suggested lecture
notes included.

¢ Audio PowerPoint Presentations provide the visual walk-through of chapters with the lecture
notes read aloud.

¢ (NEW) A & B Instruction Projects assigned to students. Students can complete the Instructional
Projects 1A and 1B and submit for instructor review or manual grading. They can also submit as a
MyITLab Grader project, which allows the students to work live in the application starting with files
downloaded from MyITLab and then submitted for automatic grading and feedback.

* (NEW) MOS Objectives are covered throughout the chapter and are indicated with the @ E icon.
Instructors use these to point students to content they would encounter on a MOS exam. If a course is
focused on MOS preparation, this content would be emphasized in the instruction.

Practice

MylTLab Skill-based Training Simulation provides students with hands-on practice applying the
skills they have learned in a simulated environment where they have access to Learning Aids to assist if
needed (READ, WATCH, PRACTICE). All of the student’s keystrokes are recorded so that instructors can
review and provide support to the students. Instructor can set the number of times the students can complete
the simulation.

MylITLab Homework Grader Projects (E, F, or G) provide students with live-in-the-application
practice with the skills they learned in Projects A and B. These projects provide students with detailed re-
ports showing them where they made errors and also provide “live comments” explaining the details.

Student Assignment Tracker for students to track their work.

Review

GO! Online activities (multiple choice and matching activities) provide objective-based quizzing to al-
low students to review how they are doing.

Testbank questions are available for instructors to create their own quizzes for review or assessment.

GO! Series Hallmarks



End-of-chapter online projects H-0 provide Content-based, Outcome-based, and Critical Thinking
projects that you can assign for additional review, practice, or assessments. These are graded manually by
the instructor using the provided Solution Files and Grading Scorecards or Rubrics.

MOS Quizzes provide an objective-based quiz to review the MOS objective-related content covered in
the chapter. Provides students with review to help if they plan to take a MOS Certification exam.

Assessment

MylTLab Skill-based Exam Simulation provides students with an assessment of their knowledge
and ability to apply the skills they have learned. In the Simulated Exams, students do not have access to the
Learning Aids. All of the student’s keystrokes are recorded so that instructors can review and provide sup-
port to the students. Instructors can set the number of times the students can complete the simulation exam.

MylTLab Assessment Grader Projects (E, F, or G) provide students with live-in-the-application
testing of the skills they learned in Projects A and B. These projects provide students with detailed reports
showing the student where they made errors and also provides “live comments” explaining the details.

Prepared Exams are additional projects created specifically for use as exams that the instructor will
grade manually. They are available by Project, Chapter, and Unit.

Pre-built Chapter quizzes provide objective-based quizzing to allow students to review how they are
doing.

Testbank questions are available for instructors to create their own quizzes for review or assessment.
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Introduction to Microsoft
Office 2016 Features

OUTCOMES

Create, save, and print a Microsoft
Office 2016 document.

PROJECT

1A

OBJECTIVES

1. Explore Microsoft Office 2016
. Enter, Edit, and Check the Spelling of Text in an Office
2016 Program
. Perform Commands from a Dialog Box
4. Create a Folder and Name and Save a File

. Insert a Footer, Add Document Properties, Print a File, and
Close a Desktop App

In This Chapter

In this chapter, you will practice using features in
Microsoft Office 2016 that work similarly across Word,
Excel, Access, and PowerPoint. These features include
managing files, performing commands, adding document
properties, signing in to Office, applying formatting to text,
and searching for Office commands quickly. You will also
practice installing apps from the Office Store and setting up
a free Microsoft account so that you can use OneDrive.

The projects in this chapter relate to Skyline Metro
Grill, which is a chain of 25 casual, full-service restaurants

OUTCOMES

Perform commands, apply
formatting, and install apps for
Office in Microsoft Office 2016

PROJECT

OBJECTIVES

. Open an Existing File and Save it with a New Name

. Sign in to Office and Explore Options for a Microsoft
Office Desktop App

. Perform Commands from the Ribbon and Quick
Access Toolbar

. Apply Formatting in Office Programs and Inspect Documents

. Compress Files and Get Help with Office

. Install Apps for Office and Create a Microsoft Account

based in Boston. The Skyline Metro Grill owners are
planning an aggressive expansion program. To expand

by 15 additional restaurants in Chicago, San Francisco,
and Los Angeles by 2020, the company must attract new
investors, develop new menus, develop new marketing
strategies, and recruit new employees, all while adhering
to the company’s quality guidelines and maintaining its
reputation for excellent service. To succeed, the company
plans to build on its past success and maintain its quality
elements.

Imagewell10/Fotolia



=2 Note Form
TA :

PROJECT ACTIVITIES

In Activities 1.01 through 1.08, you will create a note form using Microsoft Word 2016, save it in
a folder that you create by using File Explorer, and then print the note form or submit it electronically
as directed by your instructor. Your completed note form will look similar to Figure 1.1.

h
W PROJECT FILES MyITLab If your instructor wants you to submit Project 1A in the
grader | MylTLab Grader system, log in to MyITLab, locate Grader

Project1A, and then download the files for this project.

For Project 1A, you will need the following file: You will save your file as:
New blank Word document Lastname_Firstname_1A_Note_Form Plea§e
always review the
P downloaded Grader
| PROJECT RESULTS instructions before
Build From beginning.
Scratch
Skyline Metro Grill, Chef's Notes
@ Executive Chef, Sarah Jackson
Wal(l;((%!hru
Project 1A

Lastname Firstname 1A Note Form

Word 2016, Windows 10, Microsoft Corporation

FIGURE 1.1 Project 1A Note Form

2 Office | Chapter 1: INTRODUCTION TO MICROSOFT OFFICE 2016 FEATURES



@ If You Are Using a Touchscreen

Tap an item to click it.

1

Touch the screen with two or more fingers and then pinch together to zoom out or stretch your fingers apart to

‘ﬁ Press and hold for a few seconds to right-click; release when the information or commands display.
m zoom in.

% Slide your finger on the screen to scroll—slide left to scroll right and slide right to scroll left.

|

e

Slide to rearrange—similar to dragging with a mouse.

Swipe to select—slide an item a short distance with a quick movement—to select an item and bring up commands,
if any.

5

Objective 1 Explore Microsoft Office 2016

Creating a Microsoft Account

Use a free Microsoft account to sign in to Office 2016 so that you can work on different PCs and use your OneDrive. If you already
sign in to a Windows PC, tablet, or phone, or you sign in to Xbox Live, Outlook.com, or OneDrive, use that account to sign in to
Office. To create a Microsoft account, you can use any email address as the user name for your new Microsoft account—including
addresses from Outlook.com, Yahoo! or Gmail.

The term desktop application or desktop app refers to a computer program that is installed
@ on your PC and that requires a computer operating system such as Microsoft Windows. The
Cigeeriow programs in Microsoft Office 2016 are considered to be desktop apps. A desktop app typically has
hundreds of features and takes time to learn.

An app refers to a self-contained program usually designed for a single purpose and that runs
on smartphones and other mobile devices—for example, looking at sports scores or booking a
flight on a particular airline. Microsoft’s Windows 10 operating system supports both desktop
apps that run only on PCs and Windows apps that run on all Windows device families—including
PCs, Windows phones, Windows tablets, and the Xbox gaming system.

ALERT! Is Your Screen More Colorful and a Different Size Than the Figures in This
Textbook?

Your installation of Microsoft Office 2016 may use the default Colorful theme, where the ribbon in each application is a vibrant color and the
ribbon tabs display with white text. In this textbook, figures shown use the White theme, but you can be assured that all the commands are the
same. You can keep your Colorful theme, or if you prefer, you can change your theme to White to match the figures here. To do so, open any
application and display a new document. On the ribbon, click the File tab, and then on the left, click Options. With General selected on the left,
under Personalize your copy of Microsoft Office, click the Office Theme arrow, and then click White.

Additionally, the figures in this book were captured using a screen resolution of 1280 x 768. If that is not your screen resolution, your
screen will closely resemble, but not match, the figures shown. To view or change your screen'’s resolution on a Windows 10 PC, on the desktop,
right-click in a blank area, click Display settings, and then on the right, click Advanced display settings. On a Windows 7 PC, right-click on the
desktop, and then click Screen resolution.

Project 1A: Note Form | Office 3



Activity 1.01 | Exploring Microsoft Office 2016 and Creating a Blank Word Document

111

To submit as an autograded project, log into MyITLab, download the files
for this project, and then begin with those files instead of a new blank
document.

BN On the computer you are using, start Microsoft Word 2016, and then compare your screen
with Figure 1.2.

Depending on which operating system you are using and how your computer is set up, you might
start Word from the taskbar in Windows 7, Windows 8, or Windows 10, or from the Start screen in
Windows 8, or from the Start menu in Windows 10. On an Apple Mac computer, the program will
display in the dock.

Documents that you have recently opened, if any, display on the left. On the right, you can select
either a blank document or a femplate—a preformatted document that you can use as a starting
point and then change to suit your needs.

User signed in; this is optional |—— Firstname Lastname :
frft it @eumocicom (L] n
Suggested warche:  Buninews  Pemonal  Inckmtry Mt Oesign Setn [checasion Bvenet Sl by Sl

FEATURED  PERSOMAL

Starta blank G}:
document here
Recently opened documents Ta ke 2
) ) ' tour Templates
if any, display here tostart
Pl o weveerd Wekiarme 1 Woed Lirstnarrse Firstrderne 15 || dlfferent
types of
Aa Title a TITLE documents
CEECT—
T HEEN
Sirgle spaced (bland) Bl ot L L -
TITLE Title _ -

FIGURE 1.2

P2 Click Blank document. Compare your screen with Figure 1.3, and then take a moment to
study the description of these screen elements in the table in Figure 1.4.

Displaying the Full Ribbon

If your full ribbon does not display, click any tab, and then at the right end of the ribbon, click [+] to pin the ribbon to keep it open
while you work.

4 Office | Chapter 1: INTRODUCTION TO MICROSOFT OFFICE 2016 FEATURES
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FIGURE 1.3

] L] ] L] r
|
| Share button | | Window control buttons

Word 2016, Windows 10, Microsoft Corporation

SCREEN ELEMENT  DESCRIPTION

File tab

Group names

Quick Access Toolbar

Ribbon

Ribbon Display
Options

Ribbon tabs
Share button

Signed-in user
Status bar

Tell Me box

Title bar

Window control
buttons

Displays Microsoft Office Backstage view, which is a centralized space for all of your file management
tasks such as opening, saving, printing, publishing, or sharing a file—all the things you can do with a file.

Indicate the name of the groups of related commands on the displayed tab.

Displays buttons to perform frequently used commands and resources with a single click. The
default commands include Save, Undo, and Redo. You can add and delete buttons to customize
the Quick Access Toolbar for your convenience.

Displays a group of task-oriented tabs that contain the commands, styles, and resources you
need to work in an Office 2016 desktop app. The look of your ribbon depends on your screen
resolution. A high resolution will display more individual items and button names on the ribbon.

Displays three ways you can display the ribbon: Auto-hide Ribbon, Show Tabs, or Show Tabs and
Commands.

Display the names of the task-oriented tabs relevant to the open program.

Opens the Share pane from which you can save your file to the cloud—your OneDrive—and then
share it with others so you can collaborate.

Identifies the signed-in user.

Displays file information on the left; on the right displays buttons for Read Mode, Print Layout, and
Web Layout views; on the far right displays Zoom controls.

Provides a search feature for Microsoft Office commands that you activate by typing what you are
looking for in the Tell Me box; as you type, every keystroke refines the results so that you can click
the command as soon as it displays.

Displays the name of the file and the name of the program; the window control buttons are
grouped on the right side of the title bar.

Displays buttons for commands to change the Ribbon Display Options, Minimize, Restore Down,

or Close the window.

FIGURE 1.4

Project 1A: Note Form | Office 5
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Objective 2 Enter, Edit, and Check the Spelling of Text in an Office

2016 Program

All of the programs in Office 2016 require some typed text. Your keyboard is still the primary
@ method of entering information into your computer. Techniques to enter text and to edit—make

Cgesonion changes to—text are similar across all of the Office 2016 programs.

Activity 1.02 | Entering and Editing Text in an Office 2016 Program

1.4.6 I On the ribbon, on the Home tab, in the Paragraph group, if necessary, click Show/Hide [T | so
that it is active—shaded. If necessary, on the View tab, in the Show group, select the Ruler
check box so that rulers display below the ribbon and on the left side of your window, and
then redisplay the Home tab.

The insertion point—a blinking vertical line that indicates where text or graphics will be
inserted—displays. In Office 2016 programs, the mouse pointer—any symbol that displays on
your screen in response to moving your mouse device—displays in different shapes depending on
the task you are performing and the area of the screen to which you are pointing.

When you press [Enter), (Spacebar], or (Tab) on your keyboard, characters display to represent these
keystrokes. These screen characters do not print, and are referred to as formatting marks or
nonprinting characters.

Activating Show/Hide in Word Documents

When Show/Hide is active—the button is shaded—formatting marks display. Because formatting marks guide your eye in a
document—Iike a map and road signs guide you along a highway—these marks will display throughout this instruction. Many
expert Word users keep these marks displayed while creating documents.

P2 Type Skyline Grille Info and notice how the insertion point moves to the right as you type.
Point slightly to the right of the letter e in Grille and click one time to place the insertion
point there. Compare your screen with Figure 1.5.

A paragraph symbol () indicates the end of a paragraph and displays each time you press [Enter].
This is a type of formatting mark and does not print.

-0 B Detwmment! - Word ) "
Home i Design Layost  Refwescs  Malingt Review  View 0 Toll ma what you want o do Firstname Lastrarms -
— PF .
. Cobbn (Bdy) KA M- B = CE IR | AsBbCcDc | AsBbCcDx AaBRbC: AaBbicl AaB AaBblcel - % - ;
p‘:“ ."m,m Bl ren,w B-F-A-BEITE [B- S-S | Troms | Teoipsc resng!  rHadngl Titke B Tadact +
Chebasd u (= a Pacnensf - gy G Edding ~
. ' : | Show/Hide selected s =] y

| Insertion point
N | blinking to the
Rulers display i

right of e Paragraph symbol

y
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FIGURE 1.5
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EEI) On your keyboard, locate and then press the key to delete the letter e.
Pressing removes a character to the left of the insertion point.
I8 Press (=) one time to place the insertion point to the left of the / in Info. Type Chef’s and then
press one time.

By default, when you type text in an Office program, existing text moves to the right to make
space for new typing. Default refers to the current selection or setting that is automatically used by
a program unless you specify otherwise.
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B Press four times to delete Info and then type Notes
Pressing removes a character to the right of the insertion point.

3D With your insertion point blinking after the word Notes, on your keyboard, hold down the
key. While holding down (Ctrl], press |+ three times to move the insertion point to the
beginning of the word Grill. Release (Ctrl).

This is a keyboard shortcut—a key or combination of keys that performs a task that would
otherwise require a mouse. This keyboard shortcut moves the insertion point to the beginning of
the previous word.

A keyboard shortcut is indicated as + (or some other combination of keys) to indicate that
you hold down the first key while pressing the second key. A keyboard shortcut can also include
three keys, in which case you hold down the first two and then press the third. For example,

+ (Shift) + (] selects one word to the left.

) With the insertion point blinking at the beginning of the word Grill, type Metro and press
[Spacebar).

) Press + to place the insertion point after the letter s in Notes, and then press one
time. With the insertion point blinking, type the following and include the spelling error:
Exective Chef, Madison Dunham

IER With your mouse, point slightly to the left of the M in Madison, hold down the left mouse
button, and then drag—hold down the left mouse button while moving your mouse—to the
right to select the text Madison Dunham but not the paragraph mark following it, and then
release the mouse button. Compare your screen with Figure 1.6.

The mini toolbar displays commands that are commonly used with the selected object, which
places common commands close to your pointer. When you move the pointer away from the mini
toolbar, it fades from view.

Selecting refers to highlighting—by dragging or clicking with your mouse—areas of text or data
or graphics so that the selection can be edited, formatted, copied, or moved. The action of dragging
includes releasing the left mouse button at the end of the area you want to select.

The Office programs recognize a selected area as one unit to which you can make changes.
Selecting text may require some practice. If you are not satisfied with your result, click anywhere
outside of the selection, and then begin again.

G BY TOUCH Double-tap on Madison to display the gripper—a small circle that acts as a handle—directly below the word.
This establishes the start gripper. If necessary, with your finger, drag the gripper to the beginning of the
word. Then drag the gripper to the end of Dunham to select the text and display the end gripper.
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K[ With the text Madison Dunham selected, type Sarah Jackson

In any Windows-based program, such as the Microsoft Office 2016 programs, selected text is
deleted and then replaced when you begin to type new text. You will save time by developing good
techniques for selecting and then editing or replacing selected text, which is easier than pressing
the key numerous times to delete text.

Activity 1.03 | Checking Spelling

Office 2016 has a dictionary of words against which all entered text is checked. In Word and
PowerPoint, words that are not in the dictionary display a wavy red line, indicating a possible
misspelled word, a proper name, or an unusual word—none of which are in the Office 2016
dictionary.

In Excel and Access, you can initiate a check of the spelling, but red underlines do not
display.

I Notice that the misspelled word Exective displays with a wavy red underline.

P2 Point to Exective and then right-click—click your right mouse button one time.

A shortcut menu displays, which displays commands and options relevant to the selected text or
object. These are context-sensitive commands because they relate to the item you right-clicked.
These shortcut menus are also referred to as context menus. Here, the shortcut menu displays
commands related to the misspelled word.

G BY TOUCH Tap and hold a moment—when a square displays around the misspelled word, release your finger to display
the shortcut menu.

D) Press to cancel the shortcut menu, and then in the lower left corner of your screen, on
the status bar, click the Proofing icon B, which displays an X because some errors are
detected. Compare your screen with Figure 1.7.

The Spelling pane displays on the right. Here you have many more options for checking spelling
than you have on the shortcut menu. The suggested correct word, Executive, is highlighted.

You can click the speaker icon to hear the pronunciation of the selected word. If you have not
already installed a dictionary, you can click Get a Dictionary—if you are signed in to Office with a
Microsoft account—to find and install one from the online Office store; or if you have a dictionary
app installed, it will display here and you can search it for more information.

In the Spelling pane, you can ignore the word one time or in all occurrences, change the word to
the suggested word, select a different suggestion, or add a word to the dictionary against which
Word checks.
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QAN OTHER WAY  Press to display the Spelling pane; or, on the Review tab, in the Proofing group, click Spelling &
Grammar.

I3 In the Spelling pane, click Change to change the spelling to Executive. In the message box
that displays, click OK.

Objective 3 Perform Commands from a Dialog Box

@ In a dialog box, you make decisions about an individual object or topic. In some dialog boxes,

you can make multiple decisions in one place.

“ideo OF1 3 . _ _
Activity 1.04 | Performing Commands from a Dialog Box

I On the ribbon, click the Design tab, and then in the Page Background group, click Page Color.

136 P2 At the bottom of the menu, notice the command Fill Effects followed by an ellipsis (...).
Compare your screen with Figure 1.8.

An ellipsis is a set of three dots indicating incompleteness. An ellipsis following a command name
indicates that a dialog box will display when you click the command.
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